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1 MỤC TIÊU VÀ NỘI DUNG 

1.1 Mục tiêu, nội dung phương pháp xác định đảo nhiệt đô thị bằng ảnh 

vệ tinh  

1.1.1 Mục tiêu 

- Đưa ra phương pháp xác định đảo nhiệt đô thị bằng dữ liệu ảnh vệ tinh 

- Đưa ra yếu tố ảnh hưởng chính đến sự đảo nhiệt đô thị. 

1.1.2 Nội dung 

Để đạt được các mục tiêu đã nêu nghiên cứu này cần phải thực hiện các nội 

dung sau: 

a. Nghiên cứu phương pháp xác định đảo nhiệt đô thị bằng dữ liệu ảnh vệ 

tinh và đưa ra yếu tố ảnh hưởng chính đến sự đảo nhiệt đô thị bao gồm: 

 Tìm hiểu các thuật toán của phương pháp xác định đảo nhiệt đô 

thị sử dụng viễn thám; 

 Đưa ra yếu tố ảnh hưởng chính đến sự đảo nhiệt đô thị. 

b. Thực nghiệm xác định đảo nhiệt đô thị bằng dữ liệu ảnh vệ tinh Sentinel-3 

cho và sự ảnh hưởng của mật độ dân số đến quá trình đảo nhiệt đô thị. 

Hiện nay, ảnh vệ tinh hồng ngoại nhiệt có độ phân giải thời gian cao là 

dữ liệu sử dụng rất tốt cho xác định đảo nhiệt đô thị và mối quan hệ các yếu 

tố ảnh hưởng đối với khu vực đô thị hóa cao. Tuy nhiên, nhiệt độ nhận được 

từ các dữ liệu viễn thám thường chưa cao vì vậy việc sử dụng các thuật toán 

mới trong xác định đảo nhiệt đô thị được áp dụng nhằm nâng cao độ chính 

xác đối với các khu đô thị lớn có quá trình đô thị hóa nhanh. Trong nghiên 

cứu này chúng tôi sử dụng ảnh Sentinel-3 với 2 kênh phổ có bước sóng 11 

và 12 để xác định đảo nhiệt đô thị khu vực khu các quận. huyện thuộc thành 
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phố Hồ Chí Minh để thấy rõ khả năng của thuật toán sử dụng trong xác định 

nhiệt độ và các ảnh hưởng tới quá trình đảo nhiệt này. 
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2 KHÁI NIỆM VIỄN THÁM HỒNG NGOẠI NHIỆT 

2.1 Khái niệm viễn thám hồng ngoại nhiệt 

Viễn thám hồng ngoại nhiệt là một trong ba loại cơ bản của kỹ thuật 

viễn thám bao gồm viễn thám trong dải phổ quang và hồng ngoại, viễn thám 

radar, viễn thám hồng ngoại nhiệt. Viễn thám hồng ngoại nhiệt sử dụng các 

bức xạ điện từ có bước sóng trong khoảng . Tuy nhiên, trong phần 

lớn các ứng dụng của ảnh hồng ngoại nhiệt thường sử dụng dãy sóng với 

bước sóng .  

Nguyên lý cơ bản của viễn thám hồng ngoại nhiệt là ghi nhận thông 

tin về nhiệt độ bức xạ của vật thể trong dải sóng hồng ngoại nhiệt bằng 

phương pháp quét (hình 2.4). Bức xạ nhiệt có cường độ yếu, lại bị hấp thụ 

mạnh bởi khí quyển nên để thu các tín hiệu phải có thiết bị quét nhiệt với độ 

nhạy cao. Các bộ cảm biến nhiệt thường được trang bị các bộ khuyếch đại để 

ghi nhận tín hiệu về nhiệt độ bức xạ của vật chất được tốt hơn. 

Tính chất bức xạ nhiệt các đối tượng tự nhiên dựa vào nguyên lý bức 

xạ nhiệt của vật đen tuyệt đối. Vật đen tuyệt đối hấp thụ toàn bộ năng lượng 

của dải sóng điện từ và mặt trời. Tuy nhiên, trong thực tế hiếm khi có sự tồn 

tại của vật đen tuyệt đối mà chỉ có một số vật gần giống vật đen tuyệt đối 

như bồ hóng. 
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Hình 1. Nguyên lý hoạt động của viễn thám hồng ngoại nhiệt 

Ảnh hồng ngoại nhiệt rất hay bị méo hình do tín hiệu nhiệt yếu và ảnh 

hưởng của khí quyển. Bên cạnh đó, ảnh hồng ngoại nhiệt cũng phụ thuộc 

vào quán tính nhiệt của vật chất [1]. 

2.2 Bộ cảm thu ảnh viễn thám hồng ngoại nhiệt   

Đặc điểm hình học của bộ cảm hồng ngoại nhiệt 

Phương pháp thu ảnh hồng ngoại nhiệt. Do các tín hiệu thấp và 

chịu ảnh hưởng của nhiều yếu tố môi trường nên phương pháp thu ảnh hồng 

ngoại nhiệt được áp dụng phổ biến là phương pháp quét với các bộ cảm biến 

nhiệt, có trường nhìn tức thời lớn. Cấu tạo của hệ thống tạo ảnh hồng ngoại 

nhiệt bao gồm các thành phần chính sau: 

 Cảm biến nhiệt: hệ thống cảm biến nhiệt có trường nhìn tức thời 

rộng. Các tín hiệu do cảm biến nhiệt thu nhận thường phải được 

khuyếch đại lên nhiều lần trước khi ghi lại thành hình ảnh.  

 Hệ thống quét quang học. 

 Hệ thống tạo ảnh nhằm ghi lại hình ảnh từ những tín hiệu do cảm 

biến nhiệt ghi lại. Ảnh hồng ngoại nhiệt thường được thu nhận ở 

cấu trúc 8 bit. 
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Cấu tạo của một hệ thống thu nhận ảnh hồng ngoại nhiệt được mô tả 

trên hình 1.15 dưới đây. 

 

Hình 2. Cấu tạo của hệ thống thu nhận ảnh hồng ngoại nhiệt 

Đặc điểm hình học của ảnh hồng ngoại nhiệt 

Do đặc điểm của phương pháp thu nhận ảnh, ảnh hồng ngoại nhiệt rất 

hay bị méo do ảnh hưởng của các yếu tố thời tiết, môi trường như gió, mưa, 

mây, thực vật, …Bên cạnh đó, ảnh hồng ngoại nhiệt thu nhận ban ngày và 

ban đêm có sự khác biệt rất lớn do phụ thuộc vào mô hình nhiệt của các vật 

chất khác nhau (hình 1.16, khu vực có nhiệt độ cao có màu trắng sáng). 

Nhiệt độ cực đại, tốc độ nóng lên hay lạnh đi của một vật thể phụ 

thuộc vào thành phần vật chất và trạng thái của vật thể đó. Ví dụ, nước có 

giá trị nhiệt độ cực đại và cực tiểu nhỏ hơn cũng như thời điểm xuất hiện giá 

trị cực đại, cực tiểu cũng chậm hơn 1 – 2 giờ so với các đối tượng khác. Do 

vậy, nhiệt độ của địa hình thường cao hơn vào ban ngày nhưng thấp hơn vào 

ban đêm so với nhiệt độ của nước. Sự chênh lệch nhiệt độ vật chất giữa ngày 

và đêm còn gọi là quán tính nhiệt của vật chất (hình 1.14) [1, 3]. 
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Hình 3. Ảnh hồng ngoại nhiệt thu nhận vào ban ngày (trên)  

và ban đêm (dưới) 

2.3 Hệ thống vệ tinh thu ảnh viễn thám hồng ngoại nhiệt  

Một số hệ thống thu nhận ảnh hồng ngoại nhiệt 

Ảnh hồng ngoại nhiệt LANDSAT. Ngoài các kênh ảnh ở dải sóng 

nhìn thấy và hồng ngoại, trên vệ tinh LANDSAT (TM, ETM+, OLI) còn 

được trang bị bộ cảm biến nhiệt để ghi lại tín hiệu nhiệt của các đối tượng 

trên trái đất. Ảnh hồng ngoại nhiệt LANDSAT TM có độ phân giải không 

gian 120m (Bảng 1.1), trong khi ở bộ cảm biến ETM+ độ phân giải không 

gian là 60m (Bảng 1.2). Trên vệ tinh LANDSAT 8 vừa được phóng thành 

công lên quỹ đạo đầu năm 2013, ngoài bộ cảm biến quang học OLI còn 

trang bị bộ cảm biến nhiệt TIRS với 2 kênh hồng ngoại nhiệt (kênh 10, 11) 

có độ phân giải không gian 100m (Bảng 1.3). Với độ phân giải không gian 

trung bình, đặc biệt được cung cấp miễn phí với chu kỳ 16 ngày, ảnh hồng 

ngoại nhiệt LANDSAT thích hợp trong các nghiên cứu ở quy mô cấp vùng. 
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Bảng 1. Đặc điểm bộ cảm biến TM 

Kênh Bước sóng (µm) Tên gọi 

Độ phân giải 

không gian 

(m) 

1 0,45 – 0,52 Lam 30 

2 0,52 – 0,60 Lục 30 

3 0,63 – 0,69 Đỏ 30 

4 0,76 – 0,90  Cận hồng ngoại 30 

5 1,55 – 1,75  Giữa hồng 

ngoại 

30 

6 10,40 – 12,50 Hồng ngoại 

nhiệt 

120 

7 2,08 – 2,35 Giữa hồng 

ngoại 

30 

 

Bảng 2. Đặc điểm bộ cảm biến ETM+ 

Kênh Bước sóng (µm) Tên gọi 

Độ phân giải 

không gian 

(m) 

1 0,45 – 0,52 Lam 30 

2 0,52 – 0,60 Lục 30 

3 0,63 – 0,69 Đỏ 30 

4 0,76 – 0,90  Cận hồng ngoại 30 

5 1,55 – 1,75  Giữa hồng 

ngoại 

30 

6 10,40 – 12,50 Hồng ngoại 

nhiệt 

60 

7 2,08 – 2,35 Giữa hồng 

ngoại 

30 

8 0,50 – 0,90 Toàn sắc 15 

 

Bảng 3. Đặc điểm các kênh phổ ảnh LANDSAT 8 OLI 

Kênh Tên gọi Bước sóng Độ phân giải 

không gian 1 Bờ biển/Sol khí 0,433 – 

0,453 µm 

30 m 

2 Xanh lam 0,450 – 

0,515 µm 

30 m 
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3 Xanh lục 0,525 – 

0,600 µm 

30 m 

4 Đỏ 0,630 – 

0,680 µm 

30 m 

5 Cận hồng ngoại 0,845 – 

0,885 µm 

30 m 

6 Hồng ngoại sóng 

ngắn 

1,560 – 

1,660 µm 

30 m 

7 Hồng ngoại sóng 

ngắn 

2,100 – 

2,300 µm 

30 m 

8 Toàn sắc 0,500 – 

0,680 µm 

15 m 

9 Mây/quyển khí 1,360 – 

1,390 µm 

30 m 

10 Hồng ngoại nhiệt 10,30 – 

11,30 µm 

100 m 

11 Hồng ngoại nhiệt 11,50 – 

12,50 µm 

100 m 

 

Ảnh hồng ngoại nhiệt ASTER.Ảnh đa phổ ASTER được thu từ bộ 

cảm ASTER đặt trên vệ tinh Terra với độ phủ ảnh là 60 x 60 km. Bộ cảm 

ASTER được cấu thành từ 3 phụ hệ riêng rẽ, hoạt động trên từng hệ quang 

riêng biệt. Các hệ phụ này là nhìn thấy và hồng ngoại gần bao gồm các kênh 

phổ 1-3, hồng ngoại sóng ngắn gồm các kênh phổ 4-9 và hồng ngoại nhiệt 

bao gồm các kênh phổ 10-14. Như vậy, khác với ảnh hồng ngoại nhiệt 

LANDSAT, ảnh hồng ngoại nhiệt ASTER bao gồm 5 kênh phổ trong dải 

sóng 8.125 – 11.65 µm với độ phân giải không gian 60m.  

Với số lượng kênh phổ nhiều: 14 kênh, trong đó có 3 kênh trong dải 

sóng nhìn thấy với độ phân giải 15m, 6 kênh trong dải sóng hồng ngoại với 

độ phân giải 30m và 5 kênh trong dải sóng hồng ngoại nhiệt với độ phân giải 

60m, ảnh vệ tinh ASTER có khả năng cung cấp thông tin nhiều hơn các loại 

tư liệu vệ tinh khác. Ảnh hồng ngoại nhiệt ASTER đã được sử dụng phổ 

biến trên thế giới trong nghiên cứu nhiệt độ bề mặt và độ ẩm đất [1]. 

Bảng 4. Các kênh phổ ảnh vệ tinh ASTER 

Kênh 

phổ 
Bước sóng ( ) 

Độ phân giải 

không gian 

(m) 

Lưu trữ (bit) 

1 0.52 – 0.6 15 8 



12  

Kênh 

phổ 
Bước sóng ( ) 

Độ phân giải 

không gian 

(m) 

Lưu trữ (bit) 

2 0.63 – 0.69 15 8 

3 
0.76 – 0.86 (nhìn trực 

tâm) 
15 8 

3 0.76 – 0.86 (nhìn sau) 15 8 

4 1.60 – 1.70 30 8 

5 2.145 – 2.185 30 8 

6 2.185 – 2.225 30 8 

7 2.235 – 2.285 30 8 

8 2.295 – 2.365 30 8 

9 2.36 – 2.43 30 8 

10 8.125 – 8.475 60 12 

11 8.475 – 8.825 60 12 

12 8.925 – 9.275 60 12 

13 10.25 – 10.95 60 12 

 

Ảnh hồng ngoại nhiệt MODIS. Ảnh MODIS được thu nhận từ hai hệ 

thống vệ tinh chính, bao gồm: MODIS Terra và MODIS Aqua. Với tầm 

quan sát lên đến hơn 2.330 km, vệ tinh này có thể quan trắc gần như toàn bộ 

Trái Đất. Ảnh MODIS có 36 kênh phổ, với 3 độ phân giải: 250, 500 và 1000 

mét. Mặc dù độ phân giải không cao, nhưng với tầm phủ rộng, thời gian 

quan trắc liên tục và đặc biệt là miễn phí, ảnh MODIS là nguồn tư liệu giá trị 

cao trong nghiên cứu tài nguyên, môi trường. Số lượng kênh phổ lớn giúp 

ảnh MODIS được ứng dụng ngày càng nhiều trong hầu hết lĩnh vực hiện 

nay. Ảnh hồng ngoại nhiệt MODIS có độ phân giải không gian 1km đã được 

sử dụng rộng rãi trong nghiên cứu nhiệt độ nước biển, nhiệt độ và độ ẩm mặt 

đất. 
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Ảnh hồng ngoại nhiệt Sentinel-3. Ảnh Sentinel-3 SLSTR (Sea and 

Land Surface Temperature Radiometer) được thu nhận từ hai hệ thống vệ 

tinh chính, bao gồm: Sentinel-3A và Sentinel-3B. Ảnh Sentinel-3 SLSTR có 

11 kênh phổ, với 2 độ phân giải không gian: 500 và 1000 mét. Mặc dù độ 

phân giải không cao, nhưng với tầm phủ rộng, thời gian quan trắc liên tục và 

đặc biệt là miễn phí, ảnh Sentinel-3 SLSTR là nguồn tư liệu giá trị cao trong 

nghiên cứu tài nguyên, môi trường. Ảnh Sentinel-3 SLSTR được ứng dụng 

ngày càng nhiều trong hầu hết lĩnh vực hiện nay. Ảnh hồng ngoại nhiệt 

SLSTR có độ phân giải không gian 1km đã được sử dụng rộng rãi trong 

nghiên cứu nhiệt độ nước biển, nhiệt độ và hoạt động cháy. 

Bảng 5. Các kênh phổ ảnh vệ tinh Sentinel-3 SLSTR 

Band 

Central 

Wavelength 

(nm) 

Bandwidth 

(nm) 
Function Comments 

Resolution 

(metres) 

S1 554.27 19.26 

Cloud 

screening, 

vegetation 

monitoring, 

aerosol 

VNIR 

Solar 

Reflectance 

Bands 

500 

S2 659.47 19.25 

NDVI, 

vegetation 

monitoring, 

aerosol 

S3 868.00 20.60 

NDVI, cloud 

flagging, 

Pixel co-

registration 

S4 1374.80 20.80 

Cirrus 

detection over 

land 

SWIR S5 1613.40 60.68 

Cloud 

clearing, ice, 

snow,vegetati

on monitoring 

S6 2255.70 50.15 

Vegetation 

state and 

cloud clearing 

S7 3742.00 398.00 
SST, LST, 

Active fire 
Thermal IR Ambient 

bands (200 K -320 K) 
1000 

S8 10854.00 776.00 
SST, LST, 

Active fire 

S9 12022.50 905.00 SST, LST 

F1 3742.00 398.00 Active fire Thermal IR fire 

emission bands    F2 10854.00 776.00 Active fire 



14  

3 THỰC NGHIỆM XÁC ĐỊNH ĐẢO NHIỆT ĐÔ THỊ TỪ SENTINEL-3 

VÀ MỐI QUAN HỆ VỚI MẬT ĐỘ DÂN SỐ Ở CÁC QUẬN, HUYỆN 

THUỘC THÀNH PHỐ HỒ CHÍ MINH 

3.1 Thuật toán xác định nhiệt độ bề mặt 

3.1.1 Thuật toán theo hồi qui 

Công thức cơ bản của thuật toán đối với khí quyển không có mây như sau 

(Prata, 1993, 1994a, b): 

 

 , , và   là các hệ số phụ thuộc vào kiểu lớp phủ bề mặt, tỷ lệ 

thực phủ, mùa, thời điểm chụp ngày hoặc đêm, lượng mưa và  

góc  chụp của vệ  t inh . 

  và  đơn vị đo nhiệt độ độ sáng (brightness temperatures (top-

of-the  atmosphere)) trong kênh phổ SLSTR 11 µm và 12 µm; đơn 

vị độ Kelvin. 

  là góc chụp của vệ tinh. 

Nhận ra rằng các phép gần đúng thiết yếu dẫn đến một dạng tuyến tính 

cho sự phụ thuộc của nhiệt độ bề mặt vào nhiệt độ độ sáng của tầng khí 

quyển, chúng tôi đưa ra một số tính phi tuyến tính yếu bằng cách cho phép 

chênh lệch nhiệt độ thay đổi theo công suất. Sau đó, chúng tôi viết thuật 

toán dưới dạng, 

 

 , 

  là thông số điều khiển biến phụ thuộc vào góc chụp, 

 f tương ứng với tỷ lệ thực phủ. 

 

  tương ứng với kiểu thực phủ (biome), 

  tương ứng với lượng mưa (đơn vị cm). 
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Thuật toán đã được phát triển với tất cả nhiệt độ theo đơn vị độ Kelvin 

và thuật toán trả về nhiệt độ bề mặt đất theo đơn vị độ Kelvin. Nó đã được 

áp dụng hoạt động trong quá trình xử lý AATSR sau đó mặc dù với các 

trường dữ liệu phụ trợ hạn chế, đặc biệt là về phân loại quần xã sinh vật và 

bề mặt. Các yêu cầu đối với SLSTR về dữ liệu phụ trợ được quy định 

trong các phần sau. 

Tham số  có thể được đặt bằng thống nhất ) và thuật toán 

chuyển sang dạng được dẫn xuất trước đó. Mục đích của việc giới thiệu 

tham số ở đây là cho phép một số điều chỉnh thuật toán dựa trên việc phân 

tích dữ liệu kiểm định. 

Đối với trường hợp , tham số  phải được đặt bằng thống 

nhất. Những trường hợp như vậy xảy ra trong thực tế và đã được xác định 

trước đây đối với các vùng sa mạc, đặc biệt vào ban đêm và buổi sáng 

ngay sau khi mặt trời mọc. Ràng buộc này cũng có thể đạt được bằng cách 

chỉ định tham số m cho trường hợp này. Trong trường hợp có các bản cập 

nhật thuật toán khác, sẽ là khôn ngoan nhất nếu kết hợp (có / không) làm 

đầu vào để xác định xem có nên sử dụng quy trình này hay không. Lựa 

chọn có thể được kết hợp vào tệp phụ với d và m như một cột bổ sung cho 

mảng hai chiều (xem bên dưới). 

Trong quan hệ hồi quy được đề xuất, độ phát xạ không xuất hiện rõ 

ràng. Vì suy ra dựa trên công thức toán học đã cho ở trên, về nguyên tắc, 

sẽ có thể xác định các đại lượng từ (9). Tuy nhiên, hiện tại không có ý 

định xác định các chất phát xạ là một phần của sản phẩm LST, cũng như 

là một sản phẩm riêng biệt. 

Tất nhiên các hệ số phát xạ phải có mặt ngầm và điều này trở nên rõ 

ràng khi chúng ta viết ra các công thức cho các lớp của hệ số hồi quy 

trong thuật toán LST. Ba loại hệ số là: 
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  

  

  

(0  ≤  f  ≤ 1) 

Do đó, có một tập hợp các hệ số được áp dụng cho từng loại pixel tùy 

thuộc vào quần xã sinh vật i, độ phủ thực vật phân đoạn f và pw nhưng 

cũng phụ thuộc vào các giá trị ở 100% thảm thực vật (v) và đất trống (s). 

Các thông số Av, i, as, i, bv, i, bs, i và cv, i, cs, i được định nghĩa là các hệ 

số truy xuất cơ sở trong ATBD này. Tham số d, là một biến kiểm soát sự 

phụ thuộc của hơi nước vào góc nhìn và độc lập với các thông số bề mặt 

và khí quyển có thể thay đổi. 

Giá trị cho các hệ số sẽ được xác định bằng cách sử dụng tập dữ liệu 

mô phỏng trong đó các BT đã được tính toán cho một loạt các LST, các 

điều kiện bề mặt và khí quyển thích hợp (phần 3.4). Các tham số d và m sẽ 

được xác định theo kinh nghiệm bằng cách sử dụng các mô phỏng truyền 

bức xạ cho các vùng, rất có thể là nơi có sẵn một số dữ liệu xác nhận. Về 

nguyên tắc, các tham số d và m có thể phụ thuộc vào quần xã sinh vật. Do 

đó, d và m phải được cung cấp trong các tệp bổ trợ dưới dạng mảng 2-d 

với kích thước tối đa được đặt thành số lượng quần xã sinh vật và giá trị 

lớn nhất cho cả ngày và đêm cho mỗi quần xã sinh vật. Ngoài ra, có thể 

cần một cột cho cờ tiện ích; tệp tổng thể chứa d, m và cờ tiện ích phải là 2 

chiều. 

Các hệ số hồi quy riêng biệt sẽ được cung cấp cho các bề mặt trống và 

thực vật cho mỗi lớp che phủ i. Các hệ số cũng sẽ được cung cấp riêng 

biệt cho ban ngày và ban đêm. Nên có một tùy chọn để nội suy các hệ số 

giữa các tháng sẽ được thực hiện trong trường hợp đầu tiên. Sẽ không có 
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nội suy giữa hệ số ngày và đêm. Thay vào đó, các hệ số nên được chuyển 

đổi theo ngưỡng góc thiên đỉnh mặt trời có thể xác định. 

Lưu ý rằng tuyến hệ số cho thuật toán cho phép và yêu cầu dữ liệu phụ 

trợ có thể được cập nhật ở bất kỳ giai đoạn nào mà không làm thay đổi 

thuật toán xử lý cơ bản. Thật vậy đối với f, và có thể là pw, điều này là cần 

thiết. 

Hiệu chỉnh khí quyển 

Sự kết hợp của phương trình cửa sổ phân tách (split-window) ở trên và 

việc tính toán hệ số thông qua các phép tính truyền bức xạ về bản chất 

cung cấp một hiệu chỉnh khí quyển hiệu quả trong điều kiện bầu trời 

quang đãng. Sự phụ thuộc hơi nước là rõ ràng trong thuật ngữ pw trên 

toàn dải nhưng mặt khác được mong đợi sẽ được bao hàm đầy đủ thông 

qua sự phù hợp hồi quy thống kê của các hệ số truy xuất cơ sở. Điều quan 

trọng nhất là quá trình mô phỏng BT được mô tả trong Phần 3.4, và cụ thể 

là mô hình truyền bức xạ, có khả năng tính toán chính xác quá trình truyền 

trong khí quyển. Vì bầu không khí cũng có thể thay đổi đáng kể từ tháng 

này sang tháng khác, nên các hệ số được thực hiện hàng tháng. 

Sự phụ thuộc của các kênh hồng ngoại nhiệt vào hơi nước trong khí 

quyển là sự phụ thuộc quan trọng nhất của bầu trời quang đãng trong khí 

quyển. Về nguyên tắc, thông tin hơi nước từ bất kỳ cảm biến vệ tinh thích 

hợp nào sẽ hữu ích. Tuy nhiên, các hàm độ nhạy phụ thuộc vào độ cao 

(hoặc các hàm trọng số như chúng đã biết) phải được khớp với nhau để 

hiệu chỉnh tốt nhất và trên thực tế, thông tin khí quyển đầu vào phải có độ 

nhạy dọc tốt. Do đó, các thiết bị hồng ngoại nhiệt có xu hướng là nguồn 

tốt nhất nếu chúng cung cấp độ phân giải dọc và độ nhạy tầng đối lưu thấp 

hơn phù hợp với các kênh cửa sổ như đối với SLSTR. 

Tóm tắt thuật toán LST: 
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 Thuật toán LST dựa trên ba lớp hệ số được áp dụng cho các khung 

nhìn nadir của các kênh 11 và 12 µm (phương pháp tiếp cận cửa sổ 

phân tách). 

 Đối với mỗi quần xã sinh vật, phải cung cấp sáu hệ số truy xuất cơ 

sở (hai hệ số cho mỗi loại hệ số). Hệ số truy xuất sẽ được cung cấp 

cho cả ngày và đêm (tổng cộng là 12 hệ số truy xuất). Một tập hợp 

đầy đủ các hệ số truy xuất cơ sở sẽ được cung cấp cho mỗi máy dò 

do các đáp ứng phổ khác nhau của các máy dò. 

 Hệ số cơ sở nên được cung cấp hàng tháng với tùy chọn (được kích 

hoạt trong trường hợp đầu tiên) để nội suy LST thu được từ hai tập 

hợp hệ số cơ sở hàng tháng gần nhất. Các hệ số truy xuất cơ sở sẽ 

được cung cấp trong một tệp có dấu thời gian chung cho các bộ dữ 

liệu hàng tháng khác (trung tâm của tháng trong trường hợp đầu 

tiên). Nếu hệ số hàng năm là mong muốn, thì các tập dữ liệu hàng 

tháng sẽ đơn giản được lặp lại với các hệ số giống nhau. Hệ số 

trung bình hàng năm là mức tối thiểu. 

 Có hai tham số không đổi, d và m, các giá trị của chúng sẽ được 

cung cấp làm tham số phụ giống nhau cho cả hai phần tử máy dò. 

 Đối với thuật toán, góc nhìn của cảm biến (từ nadir) tại bề mặt là 

bắt buộc. Đối với đặc điểm kỹ thuật ngày / đêm (ví dụ: chuyển đổi 

các hệ số), xác minh và xác định đặc tính lỗi, góc thiên đỉnh là bắt 

buộc. 

 Nếu không có phép nội suy nào được thực hiện hàng tháng, thì tất 

cả các hệ số cơ sở sẽ được thay đổi ở ranh giới ngày hàng tháng. 

 Sẽ không có nội suy giữa hệ số ngày và đêm. 

 Điểm chuyển đổi góc thiên đỉnh mặt trời phải được chỉ định trong 
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một tệp nhưng phải được đặt thành 90 ° trong trường hợp đầu tiên. 

 Về nguyên tắc (cách tiếp cận đầu tiên), các hệ số cơ sở phải được 

nội suy trước rồi sau đó là LST được suy ra bằng cách sử dụng các 

hệ số cơ sở nội suy và dữ liệu phụ trợ được nội suy. Điều này sẽ 

đảm bảo rằng dữ liệu phụ trợ chính xác cũng được ghi vào tệp đầu 

ra; dữ liệu phụ trên mỗi pixel trong tệp đầu ra phải phù hợp với LST 

đầu ra cuối cùng trên mỗi pixel. Cách tiếp cận thứ hai là tính toán 

hai LST và sau đó nội suy các LST, tuy nhiên trong trường hợp này 

cũng phải hết sức thận trọng với các dữ liệu phụ trợ để đảm bảo tính 

nhất quán. Do đó, cách tiếp cận đầu tiên được khuyến khích. 

 Dữ liệu phụ trợ phải được cung cấp sẽ chỉ rõ, cho một vị trí không 

gian nhất định: quần xã sinh vật, thảm thực vật phân đoạn và nước 

có thể kết tủa. Số lượng quần xã sinh vật hiện tại là của Globcover, 

tức là 22, nhưng để linh hoạt trong các bản cập nhật bộ xử lý, nên 

được giả định là tối đa 50. Tất cả các tệp sẽ được lấp đầy (không có 

giá trị bị thiếu). 

 Dữ liệu bổ trợ và các tệp phụ trợ không nhất thiết phải tĩnh và quá 

trình xử lý phải linh hoạt để kết hợp thông tin cập nhật trong tương 

lai. Do đó, thông tin bổ trợ cho mỗi tham số đầu vào sẽ được lưu trữ 

trong tệp riêng biệt, nhưng tất cả thông tin về tham số đầu vào được 

lưu trữ cùng nhau trong một tệp. Các dạng tệp được xếp và đóng 

gói được chấp nhận. 
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3.2 Dữ liệu nhiệt độ bề mặt tính từ thuật toán 

Sản phẩm mức xử lý 2: SL_2_LST___ 

Sản phẩm này chứa các thông số Land Surface. 

Sản phẩm “SL_2_LST___” Mức 2 bao gồm một tệp dữ liệu đo 

lường. Trong các phần sau, nội dung của tệp này được thống kê. 

Bảng 6. SLSTR LST Thành phần vật lý sản phẩm Mức 2 

Product Package 

Type 

SL_2_LST___ 

Description 

Land Surface Parameters 

Product Level  Diss. Timeliness  
Product 

Category  

Application 

Domain  

Spatial 

Resolution 

2  NRT NTC  
Available to 

the user  
LND  1Km 

Product 

Dissemination Unit 

Stripe 

Number of 

Package 

components 

Number of 

Measurement 

Data 

Files 

Number of 

Annotation 

Data 

Files 

Number of 

Representation 

Information 

Files 

131  1  10  0 
 

Product Package 

Structure     

Manifest file (see 

[AD-8] and section 

7.1.1.2 and 8 for 

more details) 

    

File name  Composition 
   

xfdumanifest.xml  XML fields 
   

Measurement Data 

files (see section 

7.1.1.4 for more 

details) 

    

File name  Composition  N.O. 
  

LST_in.nc  

LST, LST_uncertainty, 

LST_orphan, 

LST_uncertainty_orphan, 

exception, 

exception_orphan 

   

Annotation Data 

files (see [AD-8] 

and section 7.1.1.5 

for more details) 

    

File name  Composition  N.O. 
  

LST_ancillary_ds.nc  

NDVI, NDVI_orphan, 

biome, biome_orphan, 

fraction, 

fraction_orphan, TCWV, 
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validation 

flags_in.nc  

cloud_in, bayes_in, 

pointing_in, 

confidence_in, 

cloud_orphan_in, 

bayes_orphan_in, 

pointing_orphan_in, 

confidence_orphan_in 

   

indices_in.nc  

scan_in, pixel_in, 

detector_in, 

scan_orphan_in, 

pixel_orphan_in, 

detector_orphan_in 

   

time_in.nc  

time_stamp_i, 

first_scan_in, 

first_scan_io, […] 
   

geodetic_in.nc  

latitude_in, longitude_in, 

elevation_in, 

latitude_orphan_in, 

longitude_orphan_in, 

elevation_orphan_in 

   

cartesian_in.nc  
x_in, y_in, x_orphan_in, 

y_orphan_in    

geometry_tn.nc  

solar_zenith_tn, 

solar_azimuth_tn, 

solar_path_tn, 

sat_zenith_tn, 

sat_azimuth_tn, 

sat_path_tn 

   

geodetic_tx.nc  latitude_tx, longitude_tx 
   

 

cartesian_tx.nc  
x_tx, y_tx 

met_tx.nc  

t_forecast, t_single, 

t_series, t_bound, 

z_wind, 

z_atmos, z_soil, 

z_bound, p_atmos, SST, 

sea_ice_fraction 

Representation 

Information Files  

File name  Composition 

none 
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3.3 Xử lý dữ liệu mức 2 về nhiệt độ bề mặt của Sentinel-3 SLSTR 

Chúng tôi sử dụng phần mềm SNAP để cắt các dữ liệu cần thiết ở khu 

vực nghiên cứu và chuyển đổi về hệ qui chiếu bản đồ. 

3.3.1 Mở ảnh 

File -> Open Product -> tên file.xml 

 

Hình 4. Mở ảnh nhiệt độ bề mặt Sentinel-3 ở mức 2 

 

 

Hình 5. Kết quả ảnh nhiệt độ bề mặt Sentinel-3 ở mức 2 
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3.3.2 Cắt ảnh 

Raster -> Subset -> Band Subset 

 

Hình 6. Cắt các kênh ảnh cần thiết 

Raster -> Subset -> Spatial Subset 
 

 

Hình 7. Cắt ảnh theo khu vực nghiên cứu 
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Hình 8. Kết quả ảnh cắt theo khu vực nghiên cứu 

3.3.3 Đổi hệ qui chiếu 

Raster -> Geometric -> Reproject  

 

Hình 9. Chuyển đổi hệ qui chiếu 
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Hình 10. Kết quả ảnh đã Chuyển đổi hệ qui chiếu 

3.4 Xác định đảo nhiệt đô thị theo ranh giới thành phố Hồ Chí Minh 

3.4.1 Cắt ảnh nhiệt độ bề mặt theo ranh giới thành phố Hồ Chí Minh 

Từ kết quả ảnh nhiệt độ bề mặt theo độ Kelvin sau khi chuyển về hệ qui 

chiếu, tính chuyển về độ C như hình dưới đây. 

 

Hình 11. Bản đồ nhiệt độ bề mặt theo ranh giới thành phố Hồ Chí Minh 
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3.4.2 Chuyển về bản đồ đảo nhiệt đô thị 

Sau khi tình được nhiệt độ bề mặt trung bình của các quận, huyện, thực 

hiện xác định nhiệt độ thấp nhất của thành phố và trừ tất cả nhiệt độ ở các quận 

cho nhiệt độ thấp nhất để nhận được độ chênh nhiệt độ ở các quận, huyện so 

với nhiệt độ thấp nhất để nhận được bản đồ đảo nhiệt đô thị ở TP. Hồ Chí Minh 

như hình dưới đây. 

 

Hình 12. Bản đồ đảo nhiệt đô thị các quận, huyện ở thành phố Hồ Chí Minh 

3.5 Xác định mật độ dân số theo quận, huyện theo ranh giới thành phố 

Hồ Chí Minh 

Mật độ dân số theo từng quận, huyện (người/km2) được thể hiện dưới dạng tỷ 

lệ hình tròn to, nhỏ tương ứng và hiển thị lên theo đơn vị hành chính các quận, 

huyện ở trung tâm thành phố như hình dưới đây. 
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Hình 13. Bản đồ mật độ dân số và đảo nhiệt đô thị các quận, huyện ở thành 

phố Hồ Chí Minh 

 Sau khi đưa kết quả mật độ dân số các quận, huyện ở thành phố Hồ Chí 

Minh lên nền bản đồ đảo nhiệt đô thị, nhận thấy hiện tượng đảo nhiệt đô thị xẩy ra 

ở mức độ cao đối với các quận có mật độ dân số cao do các hoạt động kinh tế - xã 

hội ở các quận này mạnh mẽ hơn (mức độ đô thị hóa cao hơn) các quận, huyện 

khác. Kết quả bước đầu cho thấy ảnh hưởng của đô thị hóa nhanh do mật độ dân 

số cao ở thành phố Hồ Chí Minh. 
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4 KẾT LUẬN  

Nội dung nghiên cứu đã trình bày bao gồm các vấn đề sau đây: 

1. Đã trình bày chi tiết phương pháp xác định nhiệt độ bề mặt theo các thuật 

toán đối với dữ liệu Sentinel-3 SLSTR; 

2. Đã trình bày cụ thể các bước thực nghiệm thành lập bản đồ đảo nhiệt đô thị 

cho các quận, huyện ở thành phố Hồ Chí Minh; 

3. Đã trình bày kết quả mật độ dân số trên nền bản đồ đảo nhiệt đô thị cho các 

quận, huyện ở thành phố Hồ Chí Minh. 
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